
MYOB Learning Centre  795

Month-end 
Procedures
Table of Contents

Chapter 1: Month-end Procedures Overview 797
Reviewing and printing your trial balance 797
Reviewing and adjusting budgets 797
Reviewing cash flow 798
Reviewing items� order status 798
Purging information that�s no longer needed 799
Reconciling chebank accounts 801
Paying PAYE and NIC�s 804
Other month-end procedures 805
Closing accounting periods 806

Chapter 2: Reviewing your trial balance 807
To print a trial balance (or nominal ledger) 807
To review your trial balance 808

Chapter 3: Reviewing and adjusting budgets 809
To print a balance sheet or P&L for budget analysis 809
To review your budget 809
To change a budgeted amount 811

Chapter 4: Reviewing cash flow 812
To review cash flow 812

Chapter 5: Reviewing items� order status 814
To review your items� order status 814

Chapter 6: Purging information that�s no longer needed 815
To purge closed invoices 815
To view purged information in the Sales Journal-if you purged detail only 816



Month-end Procedures

796   http://www.myob.com.uk/

To purge closed purchases 817
To view purged information in the Purchases Journal-if you purged detail only818
To purge journal entries 818
To purge activity slips 819
To purge business contacts 820

Chapter 7: Reconciling accounts 822
To reconcile an account 822
To reconcile an account for the first time using Accounting Plus 825

Chapter 8: Using statements downloaded from the Internet 827
To match an unmatched statement transaction with an uncleared recorded 
transaction 827
To record an unmatched statement transaction as a new transaction and 
automatically clear it 828

Chapter 9: Paying PAYE and NIC�s 829
To print the Employer�s Payment Record Report 829
To complete Inland Revenue Form P30B (Monthly Payslip) 829

Chapter 10: Closing accounting periods 831
To close an accounting period 831



Chapter 1   Month-end Procedures Overview

     MYOB Learning Centre  797    

C h a p t e r  1

Month-end Procedures 
Overview

Month-End Procedures Overview;overview:Month-End Procedures;end of month procedures;period-end procedures;accounting periods:period-end procedures

Month-end procedures usually are performed at the end of every month, 
but they can be done at any time during the month. The key to success is to 
perform these tasks regularly. Some tasks need to be performed at a 
specified time every month. Consult your accountant if you�re unsure which 
of these tasks are required for your business.

Reviewing and printing your trial balance
trial balances:reviewing;trial balances:printing;reviewing:trial balances;printing:trial balances;<$nopage>nominal ledgers:<Emphasis>See<Default Para Font> trial balances and accounts

Reviewing a trial balance report�also known to accountants as a nominal 
ledger�regularly is an optional month-end task, but it can make your job 
easier in the future. If you regularly review your trial balance, you�ll spot 
incorrectly recorded amounts quickly and will be able to fix them without 
much effort. If you decide to skip this procedure, however, and an error 
appears, you may find yourself sifting through several month�s worth of 
transactions trying to find the one that�s incorrect.

See the following step-by-step procedures:

�To print a trial balance (or nominal ledger)� on page 807

�To review your trial balance� on page 808

Reviewing and adjusting budgets
budgets:reviewing;budgets:adjusting;reviewing:budgets

Reviewing the monthly amounts you�ve budgeted for your accounts will 
help you keep your fingers on the pulse of your business. The best way to do 
this in Accounting Plus is to consult a special balance sheet, called the 
Analyse Balance Sheet, that�s designed specifically for budget analysis.

You can print the Analyse Balance Sheet report, which lists your accounts� 
actual balances for the current month, along with the amounts you 
budgeted for them. If you want information about customising the Analyse 
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Balance Sheet report, see �Choosing settings for a specific report� on 
page 978. Please note, though, that you don�t need to make any 
modifications to print the balance sheet in its standard format.

If you�ve determined that changes need to be made to the amounts you�ve 
budgeted for the coming months, you can adjust your budget. 

See the following step-by-step procedures:

�To print a balance sheet or P&L for budget analysis� on page 809

�To review your budget� on page 809

�To change a budgeted amount� on page 811

Reviewing cash flow
cash flow:reviewing;reviewing:cash flow;Cash Flow Worksheet window;forecasting:cash flow

Having an acceptable supply of available cash can often make a huge 
difference in determining how well your company performs next month. In 
Accounting Plus, you can use the Cash Flow Worksheet window to estimate 
your short-term cash needs by using information you�ve entered throughout 
Accounting Plus to create a forecast of your chebank accounts� future.

The information used in the Cash Flow Worksheet window to forecast cash 
needs comes from recurring Spend Money and Receive Money transaction 
information that you�ve entered in Accounting Plus, as well as the sales and 
purchases that will fall due during the time frame you�ve selected.

Because each company�s business practices are unique, we can�t tell you 
precisely what you should look for when reviewing your cash flow. Your 
accountant can give you additional ideas based on the way your company 
does business.

See the following step-by-step procedure:

�To review cash flow� on page 812

Reviewing items� order status
order status:reviewing;items:order status:reviewing;order book;reviewing:items� order status;Analyse Stock window

Knowing what items you have on hand is fairly simple. Knowing which 
items are on order from suppliers and promised to customers is more 
complicated. Many businesses keep what they call an �order book.� It�s 
what they use to track the comings and goings of stock items. 
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The Analyse Stock window functions as your �order book� by monitoring 
what you have:

� On hand

� On order (purchase orders) from suppliers

� On backorder (sales orders) to customers

The Analyse Stock window allows you to review the current status of the 
items you�ve entered into the MYOB system. The fields in this window are 
display-only; that is, you can�t change any of the information using this 
window. You should note that the Analyse Stock window shows quantity 
information only. If you want to see past sales activity of items, use the 
Analyse Sales window to do so.

See the following step-by-step procedure:

�To review your items� order status� on page 814

Purging information that�s no longer needed
purging:defined;company files:purging information

After you�ve used MYOB Accounting Plus for a long time, you�ll notice that 
the size of your company file has grown considerably. Information such as 
journal entries, invoices, purchases, activity slips and business contacts 
build up over time. When your company file has grown larger than you 
want it to, you may want to remove the parts of the data that are no longer 
needed from the file. The process of removing data from your company file 
is called purging. 

purging:recommended order of purging information

When you purge information from your records, you should plan out a 
strategy to do so. We strongly recommend that you purge your information 
in the following order:

Note:  Purging is based on your current 
financial year setup

When you select the month before which you want to purge, 
Accounting Plus checks the current financial year of your 
company file and uses the selected month of your current 
financial year as the basis for deciding which transactions to 
purge. Before you purge, check the current financial year of 
your company file using the Company Information window.
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1. Closed invoices

2. Closed purchases

3. Journal entries

4. Activity slips

Business contacts can be purged at any time. 

You can purge activity slips that haven�t been billed on invoices. If you�ve 
billed an activity slip on an invoice, you can purge that activity slip only if 
the invoice on which it was billed has been purged.

See the following step-by-step procedures:

�To purge closed invoices� on page 815

�To purge closed purchases� on page 817

�To purge journal entries� on page 818

�To purge activity slips� on page 819

�To purge business contacts� on page 820

Viewing transactions after purging
purging:viewing purged information;viewing:purged information

If you choose Purge Detail Only when purging sales and purchases the 
detail information that was entered in the scrolling list section of the sale or 
purchase will be removed; information, such as, ID number, date, customer 
or supplier name, memo, comment, salesperson and supplier invoice 
number or customer purchase order number for each closed sale and 
purchase will remain. The zoom arrow that appears before journal entries 
for these sales and purchases will be gray. Click the zoom arrow to display 
the window in which the original transaction was entered -- detail 
information mentioned above will not display. You won�t be able to make 
any changes to this window.

If you choose Purge Entire Sale or Purge Entire Purchase, all information 
about the closed sales and purchases will be removed. The journal entry will 
remain in the Sales or Purchases Transaction Journal window, but no zoom 
arrow will appear; you�ll no longer be able to display the window in which 
the original transaction was entered. 
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If you purged entire closed sales or purchases and you wish to also remove 
the journal entries for these closed transactions from the Sales or Purchases 
Journal, follow the steps for �To purge journal entries� on page 818.

See the following step-by-step procedure:

�To view purged information in the Sales Journal-if you purged detail 
only� on page 816

�To view purged information in the Purchases Journal-if you purged 
detail only� on page 818

Reconciling chebank accounts
reconciling:accounts;bank accounts:reconciling;accounts:reconciling;statements:reconciling accounts;reconciling:statements;<$nopage>bank statements:<Emphasis>See<Default Para Font> reconciling;chequebook reconcilication<Emphasis>See<Default Para Font> reconciling;reconciliation report:<Emphasis>See<Default Para Font> 

reconciling;bank reconciliation:<Emphasis>See<Default Para Font> reconciling

To ensure the accuracy of your business records, you should keep a record 
of your chebank accounts� balances matched up with your bank�s records. 
This task is called reconciling accounts. If this is the first time you�re 
reconciling an account using MYOB Accounting Plus, be sure to see 
�Reconciling an account for the first time� on page 802 for additional 
information.

Once you�re sure all the cheques and deposits that appear on your bank 
statement are entered in Accounting Plus, you�re ready to reconcile your 
account.

If you download bank or credit card statement files from the Internet to 
your computer, MYOB Accounting Plus automatically matches transactions 
from the statement file to those within your company file. Once the match 
takes place, that transaction is marked as cleared in the Reconcile Accounts 
window. See �Using statements downloaded from the Internet� on page 803 
for more information.

out of balance:reconconciling accounts;accounts:reconciling:out of balance;reconciling:out of balance

If your account is out of balance, a window will indicate the amount by 
which your account is out of balance, and will provide you with a few ideas 
of how the out-of-balance situation might have occurred. Here are some 
additional things you might want to verify:

� Are all the cheques and deposits that appear on your bank statement 
marked in the Reconcile Accounts window? Check to be sure the deposit 
and withdrawal amounts that appear on the Total Cleared line near the 
bottom of the Reconcile Accounts window are the same as the total 
deposit and withdrawal amounts on your bank statement.
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� Did you mistakenly mark a transaction that doesn�t appear on your bank 
statement?

� Did you make the correct entry in the New Statement Balance field? (Be 
sure you entered the ending balance from your statement, not your 
beginning balance.)

� Are all deposits accounted for? If the bank statement shows a higher 
balance than the balance calculated by Accounting Plus, a previously 
cleared deposit may have been deleted and not reentered, or reentered but 
not marked as cleared.

If you decide to exit the Reconcile Accounts window without successfully 
reconciling a chebank account, the transactions marked as cleared remain 
marked. You can pick up where you left off at any time.

bank service charges:entering;interest:entering;service charges:entering

If you wish, you can enter bank service charges and interest using the 
Reconcile Accounts window. You�ll click the Bank Entry button to open the 
Bank Entry window. If you�ve received bank service charges, enter an 
amount in the Service Charges section. If the account you�re reconciling is a 
Detail Chebank Account, the bank fee, when recorded, will appear as a 
cheque transaction assigned to the chebank account you�re reconciling. The 
next available cheque ID number is assigned to the transaction. (If the 
account you�re reconciling is a Detail Account, a Nominal Journal entry will 
be recorded.) Verify the date and enter the account you wish to allocate the 
charges to (usually an expense account). Add a memo if you wish.

If you received interest, you�ll enter an amount in the Interest Earned 
section. If the account you�re reconciling is a Detail Chebank Account, the 
interest, when recorded, will appear as a deposit transaction assigned to the 
chebank account you�re reconciling. The next available deposit ID number 
is assigned to the transaction. (If the account you�re reconciling is a Detail 
Account, a Nominal Journal entry will be recorded.) Verify the date and 
enter the account you wish to allocate the bank interest to (usually an 
income account). Add a memo if you wish.

Reconciling an account for the first time
reconciling:accounts:for the first time;accounts:reconciling:for the first time

When you reconcile an account for the first time using Accounting Plus, 
some of the cheques you wrote and some of the deposits you made before 
you began using MYOB Accounting Plus will probably be reflected in your 
bank statement. In order to reconcile the account, these transactions must 
also appear in the Reconcile Accounts window. Because you conducted the 
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transactions before you began using Accounting Plus, though, there will be 
no Accounting Plus record of those transactions. This situation must be 
resolved before you can reconcile the chebank account.

To resolve the situation, you�ll create a nominal journal entry. Each 
uncleared cheque and uncleared deposit you conducted before using 
Accounting Plus should be entered as line items on a general journal entry. 
When you�re ready to reconcile the bank account, each line of the general 
journal entry will appear in the Reconcile Accounts window. 

You�ll enter your bank account in the Acct No. column of the General 
Journal window. The individual deposit amounts should be entered in the 
Debit column and the individual cheque amounts should be entered in the 
Credit column.

It�s unlikely that the debits will equal the credits in the Record Journal Entry 
window. If there is an out of balance amount, you need to enter another line 
item with an amount that balances the debits and credits.

Since the nominal journal entry you create debits and credits the chebank 
account for the same amount, the journal entry will not affect the balance of 
the chebank account. 

See the following step-by-step procedures:

�To reconcile an account� on page 822

�To reconcile an account for the first time using Accounting Plus� on 
page 825

Using statements downloaded from the Internet
statements:using after downloading from Internet;downloading:using statements from Internet;Internet:downloading statements;reconciling:using statements after downloading from Internet

You can download bank or credit card statement files from the Internet to 
your computer and MYOB Accounting Plus will automatically match 
transactions from the statement file to those within your company file. 

The file formats that are supported by MYOB Accounting Plus for 
automatic matching are: OFX, OFC, QFX, QIF. Contact your bank or credit 
card company to receive instructions for the actual downloading 
procedures.

Once the transaction match takes place, that transaction is marked as 
cleared in the Reconcile Accounts window. 
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If no match is made of a statement transaction to a transaction in your 
company file the statement transaction remains on the list that appears in 
the Unmatched Statement Transactions window. You can select an 
unmatched transaction in this window and either:

�  Match the statement transaction to a previously recorded transaction in 
your company file. The transaction is then marked as cleared in the 
Reconcile Accounts window.

-- OR --

� Add the statement transaction to your company file. It will then appear in 
the list of transactions in the Reconcile Accounts window.

See the following step-by-step procedures:

�To match an unmatched statement transaction with an uncleared 
recorded transaction� on page 827

Paying PAYE and NIC�s
PAYE:paying;NIC�s:paying;paying:PAYE;paying:NIC�s

Monthly payments of all the PAYE and NIC�s due for each tax month must 
be paid to the Inland Revenue Accounts Office within 14 days of the end of 
that tax month. Because tax months end on the 5th you must pay that 
amount by the 19th. 

Warning: Add or match every unmatched 
transaction in a single session!

We recommend you finish adding or matching every 
transaction in the unmatched transaction list before you click 
the Done button.

When you click Done, the transactions you added or matched 
in the Unmatched Statement Transactions window are 
updated in the Reconcile Accounts and Bank Register 
windows. However, if you open the Statement file again, the 
original unmatched statements list reappears.
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Consult your accountant or the Inland Revenue if you�re unsure about how 
or when to pay PAYE and NIC. You can use the Employer�s Payment 
Record (P32) Report to help you determine the amount you owe the Inland 
Revenue. 

In most cases payments are calculated by: 

1. Adding together all the tax that you have deducted from your employees 
and all the NIC�s (employee�s and employer�s) due 

2. Subtracting tax that you may have refunded, any SSP and SMP you are 
entitled to recover as well as any NIC Rebate or NIC Holiday amounts. 

See the following step-by-step procedure:

�To print the Employer�s Payment Record Report� on page 829

�To complete Inland Revenue Form P30B (Monthly Payslip)� on 
page 829

Other month-end procedures
Many procedures in Accounting Plus can also be considered month-end 
procedures. The following procedures might be performed at the end of the 
month at your company; we suggest you click on the links below to learn 
how to perform these tasks.

Printing customer statements
Most businesses send statements of sales activity to their customers at the 
end of each month. See �Printing statements� on page 283 for more 
information. 

Analysing sales
sales:analysing;analysing:sales

It�s a good idea to be aware of your company�s sales activity and trends on a 
month-by-month basis. The Analyse Sales window can provide you with a 
graphical representation of your monthly sales. See �Reviewing your sales 
activity� on page 285 for more information.

Note: Accounting Plus will not calculate NIC 
Holiday! 

Accounting Plus does not calculate NIC Holiday. If you have 
any employees that you can claim this for you�ll need to work 
out this amount manually.
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Analysing purchases
sales:analysing;analysing:sales

Tracking your company�s monthly expenses is a wise business practice. See 
�Reviewing your purchase information� on page 398 for more information.

Counting items in stock
Staying on top of your stock quantities can make the difference between 
making sales and losing sales. Therefore, it�s a good idea to check your 
current stock levels at regular intervals and be sure your Accounting Plus 
records match your actual quantities. See �Counting stock items� on 
page 538 for more information.

Recording unrealised gains and losses
If you use the Multicurrency feature of Accounting Plus, you may need to 
make a journal entry to record your company�s unrealised gains and losses 
for the current month and reverse the previous month�s entry. See �To 
record unrealised gains and losses� on page 788 for more information.

Closing accounting periods
accounting periods:closing;closing:accounting periods

MYOB Accounting Plus doesn�t require you to close accounting periods. 
The things you do to �close� an accounting period are more for the sake of 
keeping track of your periodic business activity, so you have accurate 
historical records to refer to in the future. As a result, the tasks listed below 
are merely suggestions�but they�re suggestions that may help you out a 
great deal someday. 

accounting periods:locking;locking:closed accounting periods

Accounting Plus allows you to �lock� the closed accounting period to 
prevent you from inadvertently making an entry in a month in which you 
don�t want new entries. This �lock� affects the month you select and all 
months before it. If, at a later time, you need to make an entry in a month 
that occurs before the month you selected here, simply change your 
selection here so that month is �unlocked� and available for transaction 
entry again.

See the following step-by-step procedure:

�To close an accounting period� on page 831
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C h a p t e r  2

Reviewing your trial 
balance
Printing a trial balance (or nominal ledger)

4 To print a trial balance (or nominal ledger)
trial balances:printing;printing:trial balances

If you haven�t already read the Month-end Procedures Overview, see 
�Reviewing and printing your trial balance� on page 797 for more 
information.

The Index to Reports window  should be displayed

1. Select the Accounts tab to display a scrolling list of reports that are 
associated with the Accounts Command Centre.

2. Highlight the Trial Balance selection.

3. Click the Customise button. Make account, date and sort selections.

Choose the option Include Accounts with No Activity if you wish to 
display all accounts, even those accounts that have no transactions 
recorded between the beginning and ending dates that have been selected 
for this report. 

4.  Click OK to redisplay the Index to Reports window.

5. Click the Print button.
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Reviewing your trial balance

4 To review your trial balance
trial balances:reviewing;reviewing:trial balances

If you haven�t already read the Month-end Procedures Overview, see 
�Reviewing and printing your trial balance� on page 797 for more 
information.

When you review the report, look for: 

� Entries that seem unusually high or low for the account that�s been affected

� Debit amounts for accounts that normally have credit entries, and vice 
versa

� Unusually high or low ending balances

� An unusually high or low number of entries for a specific account



Chapter 3   Reviewing and adjusting budgets

     MYOB Learning Centre  809    

C h a p t e r  3

Reviewing and 
adjusting budgets
Printing a balance sheet for budget analysis

4 To print a balance sheet or P&L for budget 
analysis
balance sheets:printing for budget analysis;Profit & Loss (Budget Analysis) report:printing for budget analysis;budgets:analysing:printing balance sheets;budgets:analysing:printing Profit & Loss (Budget Analysis) report;printing:Profit & Loss (Budget Analysis) report for budget analysis;printing:balance sheet for budget analysis

If you haven�t already read the Month-end Procedures Overview, see 
�Reviewing and adjusting budgets� on page 797 for more information.

The Index to Reports window  should be displayed.

1. Select the Accounts tab to display a scrolling list of reports that are 
associated with the Accounts Command Centre.

2. Highlight the Balance Sheet (Budget Analysis) selection.

3. Click the Customise button; the Report Customisation window appears. 
Check to be sure that the correct month has been selected for the report; 
also be sure that level 4 is selected, so you can see comparison information 
for all the accounts in your accounts list. 

4. Click OK to redisplay the Index to Reports window.

5. Choose the Print button.

6. Repeat the process from step 1 for the Profit & Loss (Budget Analysis) 
report.

Reviewing your budgets

4 To review your budget
budgets:reviewing;reviewing:budgets
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If you haven�t already read the Month-end Procedures Overview, see 
�Reviewing and adjusting budgets� on page 797 for more information.

When reviewing the Balance Sheet (Budget Analysis) or Profit & Loss 
(Budget Analysis) report, begin by looking at the £ Difference column on 
the right side of the report. This column shows the difference between the 
amount you budgeted to spend during the month and the amount you 
actually recorded for each account in your accounts list. Many accounts 
will have a slight variation from the amount you�ve budgeted�that�s 
normal. What you�re concerned with is an unusually large departure from 
the amount you�ve budgeted.

Here are some differences that should be of particular concern to you: 

� Sales accounts that are lower than projected.

� Expenses that are higher than you�d planned. If your expenses often exceed 
your expectations, you may need to put spending controls in place.

� Wage or salary expenses that are different than you�d planned. This could 
mean you�re paying more overtime than you�d planned to, for example.

� Stock balances that are significantly different than you�d projected. This 
could mean that you�ve got too much�or too little�stock on hand. Both 
of these situations can create a financial drag on your business.

� Aged creditors that are higher than expected. Aged creditors need careful 
management to ensure that you�re not paying your bills before you have to, 
but also aren�t losing discounts and paying unnecessary interest charges.

� Aged debtors that are higher than expected. This may mean that your 
customers are taking longer than anticipated to pay off their accounts with 
you.

Any significant variation from the amount you�ve budgeted deserves further 
investigation, but these are key areas for you to consider. 

Idea: If you need to change your budgets
Make a note on the report of any changes that are needed to 
your budgets for future periods. That will make your next 
task�adjusting the budgets�easier.
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Adjusting budgets

4 To change a budgeted amount
budgets:adjusting

If you haven�t already read the Month-end Procedures Overview, see 
�Reviewing and adjusting budgets� on page 797 for more information.

The Accounts List window should be displayed. 

1. Highlight an account you want to change.

2. Click Edit. The Edit Accounts window appears, displaying information 
about the account. 

3. Click the Budgets button to display the History and Budgets window.

4. Make any needed changes to the amounts displayed in the Budget column. 

Remember to enter only the expected change (increase or decrease) in the 
account�s balance; don�t enter the expected balance for the account during 
the month in question. Also be sure to enter a positive amount if you 
expect the account�s balance to rise. Even if the amount represents an 
expense to your company, it should be positive if it causes the account�s 
balance to rise.

5. Click OK. 

6. Click OK in the Edit Accounts window to redisplay the Accounts List 
window. 

7. Select another account if you need to make additional budget changes, or 
click Close if you don�t have any more changes to make.
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C h a p t e r  4

Reviewing cash flow
Reviewing cash flow

4 To review cash flow
cash flow:reviewing;reviewing:cash flow;Cash Flow Worksheet window

If you haven�t already read the Month-end Procedures Overview, see 
�Reviewing cash flow� on page 798 for more information.

The Cash Flow Worksheet window  should be displayed.

1. Choose the bank account you want to analyse from the Bank Account list.

2. Enter the number of days for which you want to analyse your cash needs in 
the Days To Look Ahead field. When you make your entry here, the list in 
the middle of the window will display all the transactions your company is 
due to perform during the time period you specified. Any transactions that 
are overdue also appear here. 

3. You can change any of the information that appears in the list to better 
estimate your cash flow needs. 

You can also add transactions to the list. To do this, scroll to the bottom of 
the list and add transaction information in the blank line. When you�re 
finished, press TAB to create a new blank line, where you can enter 
additional transaction information.

4. Click the Analyse Cash Needs button at the bottom of the window.

Note: The Cash Flow Worksheet doesn�t affect 
your company file

Changes, deletions and additions you make in the list are used 
for the purposes of the Cash Flow Worksheet window only. 
The changes you make here won�t be reflected anywhere else 
in the MYOB system.
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5. A new view of the Cash Flow Worksheet window appears, listing all the 
transactions that appeared in the previous list. Their corresponding 
amounts appear in the Amount column. The running balance of the 
account as it is affected by each transaction appears in the Cash Available 
column. You can simply view the information here if you like, or you can 
click the Print button to print a copy of the Cash Flow Analysis Report that 
contains the information displayed on your computer screen.

6. Click the Return to Worksheet button and make more changes to the list of 
transactions, if you wish. Experiment with the two views of the window to 
make different forecasts of your account.

7. Click Cancel. 
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C h a p t e r  5

Reviewing items� order 
status
Reviewing items� order status

4 To review your items� order status
order status:reviewing;items:order status:reviewing;order book;reviewing:items� order status;Analyse Stock window

If you haven�t already read the Month-end Procedures Overview, see 
�Reviewing items� order status� on page 798 for more information.

The Analyse Inventory window  should be displayed.

1. Two different views are available in the Analyse Stock window: Summary 
and Detail. 

� Summary view       This view, displayed by choosing the Summary 
selection at the top of the window, allows you to view quantity 
information for all items in the MYOB Accounting Plus system. This 
view shows the actual quantity on hand for each item, as well as 
number of items committed on sales orders, on order on purchase 
orders, and available.

� Detail view       This view, displayed by entering a specific item number 
in the Item No.field at the top of the window, allows you to view order 
information for a single item at a time. The Detail view can also be 
displayed from the Summary view by clicking the zoom arrow next to 
an item�s number. 
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C h a p t e r  6

Purging information 
that�s no longer needed
Purging closed sales

4 To purge closed invoices
purging:closed invoices;sales:purging closed sales;closed invoices:purging;invoices:purging closed invoices

If you haven�t already read the Month-end Procedures Overview, see 
�Purging information that�s no longer needed� on page 799 for more 
information.

Please note that this task requires single-user access. See �Single-user file 
locking� on page 763 for more information.

purging:effects on analysis capabilities 

1. Print all the reports that you wish to keep that show the closed sales you�ll 
be purging. You might consider printing a copy of the Sales Journal, which 
contains detailed information about all sales.

Warning:  Purging information will change the 
way you view your financial activity

Various types of information, including journal entries, closed 
sales and purchasing transactions, activity slips and contact 
logs, can be removed from a company file. The information 
you can remove won�t prevent you from keeping accurate 
financial records, but removing some types of information 
could change the way you analyse your information. We 
suggest you carefully consider the results of purging data from 
your company file before you do so. Although you can recover 
the information from a backup copy of the company file, the 
process may take more time and effort than you�re willing to 
invest.   
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2. Make a backup of your company file. Clearly mark this backup and put it 
in storage as part of your permanent records.

3. Open the Sales Command Centre.

4. Choose Purge Closed Invoices from the File menu. The Purge Closed 
Invoices window appears.

5. From the Purge Invoices Close BEFORE list, choose the first month for 
which you don�t want to remove closed invoices. Be especially careful 
when you select a month�don�t include an accounting period that isn�t 
completely closed. All closed invoices dated prior to the month you select 
are marked for purging.

6. Choose to purge detailed information about closed invoices only, or to 
purge entire closed invoices. 

7. Click the Continue button. Another Purge Closed Invoices window 
appears, listing all customers in the Card File.

8. From the list of customers, select the customers whose closed sales you 
want to purge. If you wish to keep closed invoices for any customers, 
remove the x that appears next to each of the customers� names by clicking 
it.

9. Click the Purge Closed Invoices button. The closed invoices for the time 
frame you specified and for the customers you selected in this window will 
be removed.

4 To view purged information in the Sales Journal-
if you purged detail only
purging:viewing purged information:using Sales Journal;viewing:purged information:using Sales Journal

If you haven�t already read the Month-end Procedures Overview, see 
�Viewing transactions after purging� on page 800 for more information.

The Transaction Journal window  should be displayed.

1. Use the scroll bar to find the purged sale you want to view.

2. Click the zoom arrow next to the closed invoice to view the original 
window in which the transaction was entered, displaying only the 
information that wasn�t purged.
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If you purged entire closed invoices, you won�t be able to view any details 
about the invoice, other than those that appear in the Sales Journal.

Purging closed purchases

4 To purge closed purchases
purging:closed purchases;closed purchases:purging;purchases:purging closed purchases

If you haven�t already read the Month-end Procedures Overview, see 
�Purging information that�s no longer needed� on page 799 for more 
information.

Please note that this task requires single-user access. See Single-user file 
locking for more information.

1. Print all the reports that you wish to keep that show the closed purchases 
you�ll be purging. You might consider printing a copy of the Purchases 
Journal, which contains detailed information about all purchases.

2. Make a backup of your company file. Clearly mark this backup and put it 
in storage as part of your permanent records. (If you�ve just purged closed 
sales and made a backup during that procedure, it�s not necessary to make 
a second backup for purchases.)

3. Open the Purchases Command Centre.

4. Choose Purge Closed Purchases from the File menu. The Purge Closed 
Purchases window appears.

5. From the Purge Purchases Closed BEFORE list, choose the first month for 
which you don�t want to remove closed purchases. Be especially careful 
when you select a month�don�t include an accounting period that isn�t 
completely closed. All closed purchases dated prior to the month you 
select will be marked for purging.

6. Choose to purge detailed information about closed purchases only, or to 
purge entire closed purchases. If you choose Purge Detail Only, the 
purchase ID number, date, supplier, delivery method, comment, delivery 
date, VAT, freight, memo and supplier invoice number for each closed 
purchase will remain. If you choose Purge Entire Purchase, all information 
about the closed purchases will be removed.

7. Click the Continue button. Another Purge Closed Purchases window 
appears, listing all suppliers in the Card File.
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8. From the list of suppliers, select the suppliers whose closed purchases you 
want to purge. If you wish to keep closed purchases for any suppliers, 
remove the x that appears next to each of the suppliers� names by clicking 
it.

9. Click the Purge Closed Purchases button. 

4 To view purged information in the Purchases 
Journal-if you purged detail only
purging:viewing purged information:using Purchases Journal;viewing:purged information:using Purchases Journal

If you haven�t already read the Month-end Procedures Overview, see 
�Viewing transactions after purging� on page 800 for more information.

The Transaction Journal window  should be displayed.

1. Use the scroll bar to find the purged purchase you want to view.

2. Click the zoom arrow next to the closed purchase to view the original 
window in which the transaction was entered, displaying only the 
information that wasn�t purged. 

If you purged entire closed purchases, you won�t be able to view any details 
about the purchase, other than those that appear in the Sales Journal. 

Purging outdated journal entries

4 To purge journal entries
purging:journal entries;journal entries:purging

If you haven�t already read the Month-end Procedures Overview, see 
�Purging information that�s no longer needed� on page 799 for more 
information.

Please note that this task requires single-user access. See Single-user file 
locking for more information.

1. Print all the reports that you wish to keep that show the transactions you�ll 
be purging. Account Transactions reports contain most of the information 
you may want to retain.

2. Make a backup of your company file. Clearly mark this backup and put it 
in storage as part of your permanent records. (If you�ve just purged closed 
sales or purchases and made a backup during one of those procedures, it�s 
not necessary to make another backup for journal entries.)
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3. Open the Accounts Command Centre. 

4. Choose Purge Journal Entries from the File menu to open the Purge 
Journal Entries window.

5. From the Purge Journal Entries BEFORE list, choose the first month for 
which you don�t want to remove journal entries. Be especially careful 
when you select a month�don�t include an accounting period that isn�t 
completely closed. All journal entries dated prior to the month you select 
will be marked for purging.

6. Click the Continue button. Another Purge Journal Entries window will 
appear, listing all the accounts in your accounts list.

7. From the list of accounts, select the accounts whose unreconciled journal 
entries you don�t want to purge. Typically, you should select the accounts 
you regularly reconcile in the Reconcile Accounts window.

8. Click the Purge Journal Entries button. The journal entries for the time 
frame you specified and for the accounts you didn�t select in this window 
will be purged. 

Purging activity slips

4 To purge activity slips 
purging:activity slips;activity slips:purging

If you haven�t already read the Month-end Procedures Overview, see 
�Purging information that�s no longer needed� on page 799 for more 
information.

Please note that this task requires single-user access. See Single-user file 
locking for more information.

Note: This is different than what you do with 
sales and purchases!

Be sure to mark the accounts that have unreconciled journal 
entries you don�t want to be removed. (Don�t make the 
mistake of marking the accounts you do want to be removed as 
you do with sales and purchases.) Be careful when you make 
your selections!
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1. Print all the reports that you wish to keep that show the activity slips you�ll 
be purging. You might consider printing an Activity Slip Report for 
Completed Work, on which you can include whatever information you 
need about the activity slips you�re about to purge.

2. Make a backup of your company file. Clearly mark this backup and put it 
in storage as part of your permanent records. (If you�ve just purged closed 
invoices, closed purchases or journal entries and made a backup during 
one of those procedures, it�s not necessary to make another backup for 
activity slips.)

3. Open the Time Billing Command Centre.

4. Choose Purge Activity Slips from the File menu to open the Purge Activity 
Slips window.

5. From the Purge Activity Slips BEFORE list, enter the first month from 
which you don�t want to remove activity slips. All activity slips dated prior 
to the month you select will be marked for purging.

identifiers:using:to choose activity slips to purge;purging:activity slips:using identifiers to help choose;activity slips:purging:using identifiers to help choose

6. If you�ve assigned identifiers to people and companies in the Card File and 
wish to purge activity slips for employees and suppliers with the same 
identifier(s), enter the identifier(s). 

7. Click the Continue button. Another Purge Activity Slips window appears, 
listing all the employees and suppliers in the Card File whose activity slips 
match the criteria you entered in the first Purge Activity Slips window.

8. From the list, select the employees and suppliers whose activity slips you 
want to purge. If you wish to keep activity slips for any employees or 
suppliers, click the x that appears next to that person�s name to remove it.

9. Click the Purge Activity Slips button. 

Purging business contacts

4 To purge business contacts
purging:business contacts;business contacts:purging

If you haven�t already read the Month-end Procedures Overview, see 
�Purging information that�s no longer needed� on page 799 for more 
information.

Please note that this task requires single-user access. See Single-user file 
locking for more information.
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1. Print all the reports that you wish to keep that show the business contacts 
you�ll be purging. You might consider printing a copy of the Contact Log 
Report, which contains detailed information about all contacts.

2. Make a backup of your company file. Clearly mark this backup and put it 
in storage as part of your permanent records.

3. Open the Card File Command Centre.

4. Choose Purge Contact Logs from the File menu to open the Purge Contact 
Logs window.

5. From the Purge Contact Logs BEFORE list, choose the first month for 
which you don�t want to remove business contacts. All business contacts 
dated prior to the month you select will be marked for purging.

6. Using the Card Type field, choose to purge business contacts for 
customers, suppliers, employees or personal contacts only, or to purge 
business contacts for all people and companies in the Card File.

identifiers:using:to choose business contacts to purge;purging:business contacts:using identifiers to help choose;business contacts:purging:using identifiers to help choose

7. If you�ve assigned identifiers to people and companies in the Card File and 
wish to purge business contacts for contacts with the same identifier(s), 
mark the Identifiers option, then enter the identifier(s).

8. Mark the Do Not Purge if Entry has a Recontact Date option if you don�t 
want to remove business contacts that have recontact dates assigned to 
them,

9. Click the Continue button. Another Purge Contact Logs window will 
appear, listing all the people and companies in the Card File that match the 
criteria you entered in the first Purge Contact Logs window. A mark 
appears in the X column next to each card name, indicating that the 
business contacts for that card will be removed.

10. Click in the X column next to the card�s name to remove the mark that 
appears there if you want to keep business contact information for any of 
the cards that are displayed, 

11. Click the Purge Contact Logs button. 
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C h a p t e r  7

Reconciling accounts
Reconciling accounts

4 To reconcile an account
reconciling:accounts;accounts:reconciling;bank accounts:reconciling;statements:reconciling accounts;reconciling:statements

If you haven�t already read the Month-end Procedures Overview, see 
�Reconciling chebank accounts� on page 801 for more information.

The Reconcile Accounts window  should be displayed.

1. Enter or select the account you want to reconcile in the Account field, and 
press TAB.

2. Enter the ending balance that appears on your bank statement in the New 
Statement Balance field.

3. Enter the closing date that appears on your bank statement in the Bank 
Statement Date field. Only unreconciled transactions dated on or before 
that date will appear in the scrolling list.

statements:reconciliation report

Note: If you�re reconciling for the first time
If you�ve never used the Reconcile Accounts window before, 
there are some special steps that you should perform before 
you begin the reconciliation process. If this is your situation, 
see �To reconcile an account for the first time using 
Accounting Plus� on page 825.

Note: Be sure to enter the ending balance!
Many bank statements have more than one balance on them. 
Be sure to enter the balance of your account at the end of the 
period.
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4. Click the Bank Entry button to open the Record Service Charges and 
Interest Earned window and enter any bank service charges you owe and 
any interest that you earned.       

Skip to step 6 if you�ve already entered the bank charges and interest 
transactions in Accounting Plus before opening the Reconcile Accounts 
window. These transactions should already appear in the transactions list.      

5. Click Record. If you need to record additional bank charges or fees, click 
the Bank Entry button again.

6. Mark each transaction in the scrolling list that appears on your bank 
statement. (Transactions entered using the Bank Entry feature are 
automatically marked as cleared.)

Note: Use care when entering the date in the 
Reconcile Accounts window

The Reconciliation Report enables you to view the status of an 
account's transactions as of a previous reconciliation date. If 
the bank statement date you enter in the Reconcile Accounts 
window is different from the date that appears on the actual 
statement you received from your bank, you may find it 
difficult to determine which date should be used to print the 
Reconciliation Report in the future.
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7. Click the Reconcile button. A window appears, indicating whether your 
account is reconciled or is out of balance.

8. If your account is reconciled, you can either reconcile the account or print 
the Reconciliation Report. 

To reconcile, click the Reconcile button; the transactions you marked are 
considered �cleared,� and won�t show up in the Reconcile Accounts 
window the next time you open it. To print the report, click Print Report; if 
you print the report, be sure to click Reconcile again to complete the 
reconciliation process after the report�s been printed.

Note: You may edit, remove or reverse 
entries using this window

If the transaction information displayed in the Reconcile 
Accounts window is incorrect, you can choose to click the 
zoom to display the original transaction entry window. 

If your records are changeable, you may edit the transaction. 
When you click OK, the updated information will appear in 
the Reconcile Accounts window. If you choose Delete 
Transaction from the Edit menu to remove the transaction, the 
transaction will no longer appear in the Reconcile Accounts 
window.

If your records are unchangeable, you may reverse the 
transaction by choosing Reverse Transaction from the Edit 
menu. After a few moments, a new transaction, containing 
amounts exactly opposite to the original transaction, will be 
displayed. When you click Record, the reversal will be added 
to the Reconcile Accounts window. If you don�t want the 
original entry and the reversal to appear the next time you 
reconcile, mark both entries to indicate they are cleared. 

See �What are changeable and unchangeable transactions?� 
on page 52 for more information.
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4 To reconcile an account for the first time using 
Accounting Plus
reconciling:accounts:for the first time;accounts:reconciling:for the first time

If you haven�t already read the Month-end Procedures Overview, see 
�Reconciling an account for the first time� on page 802 for more 
information.

1. Create a Nominal Journal entry for the bank account, with a separate debit 
for each deposit that hasn�t cleared yet and a separate credit for each 
cheque that hasn�t cleared yet. 

2. It�s unlikely that the debits will equal the credits in the Record Journal 
Entry window. If the Out of Balance field underneath the scrolling list 
shows an amount, you�ll need to enter another line item with an amount 
that balances the debits and credits.

3. Click Record. 

4. In the Chequebook Command Centre, click Reconcile Accounts to open 
the Reconcile Accounts window. 

5. Enter the account you want to reconcile in the Account field. The cheques 
and deposits you�ve entered, as well as the individual line items in the 
Nominal Journal entry you just created, appear in the scrolling list in the 
middle of the window.

6. Enter the ending balance on the statement that your bank sent you in the 
New Statement Balance field.

7. Enter the closing date that appears on your bank statement in the Bank 
Statement Date field. Only the transactions dated on or before that date 
will appear in the scrolling list.

8. Mark all cheques and deposits that are on your bank statement; also mark 
the balancing amount entry you created in step 2.

Note: You must finish reconciling after you 
print the Reconciliation Report!

If you choose to print the Reconciliation Report, be sure to 
click the Reconcile button again in the Reconcile Accounts 
window. When you choose to print the report, the reconciling 
process is stopped, and you must click Reconcile again to 
complete the process.
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9. Click Reconcile. A window appears, indicating whether your account is 
reconciled or is out of balance.

10. If your account is reconciled, you can either reconcile the account or print 
the Reconciliation Report. 

11. Click Reconcile to reconcile the account. Click Print Report to print the 
report. If you print the report, be sure to click Reconcile again to complete 
the reconciliation process after the report�s been printed.

In future months, when you receive bank statements that contain the other 
transactions you performed before you began using Accounting Plus, you 
can mark off the other line items from the Nominal Journal entry.
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C h a p t e r  8

Using statements 
downloaded from the 
Internet
Matching or adding unmatched statement 
transactions

4 To match an unmatched statement transaction 
with an uncleared recorded transaction
statements:using after downloading from Internet:matching unmatched statement transactions;downloading:using statements from Internet:matching unmatched statement transactions;reconciling:using statements after downloading from Internet:matching unmatched statement transactions

If you haven�t already read the Month-end Procedures Overview, see �Using 
statements downloaded from the Internet� on page 803 for more 
information.

The Unmatched Statement Transactions window should be displayed.

1. Highlight the transaction in the unmatched statement transaction list that 
you will match to an uncleared transaction that you previously recorded.

2. Click the Match Transaction button to open the Match Transaction 
window.

3. In the Match Transaction window, highlight the uncleared transaction to 
which you will match the selected statement transaction.    

4. Click Match. This results in two actions.

� Marks the uncleared transaction as cleared in the Reconcile Accounts 
window.

� Removes the statement transaction from the list of unmatched 
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transactions in the Unmatched Statement Transactions window.

4 To record an unmatched statement transaction 
as a new transaction and automatically clear it 
statements:using after downloading from Internet:adding unmatched statement transactions;downloading:using statements from Internet:adding unmatched statement transactions;reconciling:using statements after downloading from Internet:adding unmatched statement transactions

If you haven�t already read the Month-end Procedures Overview, see �Using 
statements downloaded from the Internet� on page 803 for more 
information.

The Unmatched Statement Transactions window  should be displayed.

1. Highlight the transaction in the unmatched statement transaction list that 
you will record as a new transaction.

2. Click the Add Transaction button. Either the Spend Money window or the 
Receive Money window opens, based on the Transaction Type the 
transaction was assigned in the statement file. 

The information in the Date, Amount and Cheque/ID No. fields 
automatically transfers to the Spend Money or Receive Money window. 

The account defaults to the account that was chosen in the Reconcile 
Accounts or Bank Register window in the steps that preceded opening the 
Unmatched Transactions window.

3. Continue the procedure for recording the transaction as outlined in 
�Receiving money� on page 242 or �Spend money� on page 197.

4. The new transaction automatically matches to the statement transaction 
and is marked as cleared in the Reconcile Accounts window.
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C h a p t e r  9

Paying PAYE and NIC�s
Printing the Employer�s Payment Record Report

4 To print the Employer�s Payment Record Report
PAYE:paying:printing Employer�s Payment Record Report;NIC�s:paying:printing Employer�s Payment Record Report;paying:PAYE:printing Employer�s Payment Record Report;paying:NIC�s:printing Employer�s Payment Record Report;Employer�s Payment Record Report:printing;printing:Employer�s Payment Record Report

If you haven�t already read the Month-end Procedures Overview, see 
�Paying PAYE and NIC�s� on page 804 for more information.

1. From the Reports menu, choose Index to Reports to open the Index to 
Reports window. 

2. Select the Payroll tab to display a scrolling list of reports that are associated 
with the Payroll Command Centre. Scroll to the Employer�s Payment 
Record (P32) Report; highlight this selection. 

3. Click the Filters button at the bottom of the Index to Reports window. 

The Report Filters window appears. You can choose a pay period for 
which you want to view your PAYE and NIC�s liabilities. The PAYE and 
NIC�s you owe on paycheques for that period will be displayed. 

4. When you�re satisfied with the selections in this window, choose OK to 
redisplay the Index to Reports window. 

5. Choose the Print button. 

Completing Inland Revenue Form P30B

4 To complete Inland Revenue Form P30B 
(Monthly Payslip)
PAYE:paying:completing Inland Revenue Form P30B;NIC�s:paying:completing Inland Revenue Form P30B;paying:PAYE:completing Inland Revenue Form P30B;paying:NIC�s:completing Inland Revenue Form P30B;Inland Revenue Form P30B

If you haven�t already read the Month-end Procedures Overview, see 
�Paying PAYE and NIC�s� on page 804 for more information.

1. In the box labelled �Income Tax� enter the PAYE amount shown in column 
9 headed �PAYE Tax� on the Employer�s Payment Record Report. 
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2. In the box labelled �Net National Insurance� enter the amount shown in 
column 8 headed �Net NIC� on the Employer�s Payment Record Report. 

3. In the box labelled �Total amount due� enter the amount shown in column 
10 labelled �Tot Due� on the Employer�s Payment Record Report.
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C h a p t e r  1 0

Closing accounting 
periods
Closing accounting periods

4 To close an accounting period
accounting periods:closing;closing:accounting periods

If you haven�t already read the Month-end Procedures Overview, see 
�Closing accounting periods� on page 806 for more information.

1. If you�ve received statements from your bank, use the Reconcile Accounts 
window to reconcile amounts in Accounting Plus with the amounts on the 
statements. See �To reconcile an account� on page 822 for more 
information about this task.

2. Print a Trial Balance or Nominal Ledger (Detail) Report for the period. 
Check to see whether the activity that appears in the report is what you 
expected; for example, zero amounts in accounts that usually have regular 
activity may indicate a problem. See �To print a trial balance (or nominal 
ledger)� on page 807 for more information about this task.

3. If the information in the trial balance reports is acceptable, print the 
reports you want to keep as part of your permanent business records. 
Suggested reports include the balance sheet, profit and loss statement, 
Aged Creditors Report, Aged Creditors Report and all journal reports.

4. Make a backup of your company file. Clearly mark this backup and put it 
in storage as part of your permanent records.
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5. Choose Preferences from the Setup menu to open the Preferences window. 

6. Select the Security tab.

7. Change your selection in the Lock Periods list to the period you�re closing.

Idea: Check your company file for errors 
before proceeding

To be completely sure that your company file is sound, we 
recommend that you use the Accounting Plus data verification 
feature before you continue. You can check your data for 
errors during the backup process, if you wish. For more 
information about data verification, see �Verifying company 
files� on page 689.
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